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1 Presentation 
CYPE 3D is a powerful and efficient program brought about to carry out structural 

calculations in 3 dimensions of steel, aluminium and timber bars. 

The program obtains the forces and displacements based on an automatic design. It 

possesses a laminated, welded and cold formed steel section database. It analyses any 

type of structure carrying out all the verifications and checks the selected code requires. 

Thanks to the generation of structural views, the user can work with windows in 2D and 3D 

in a completely interactive manner. The structure can equally be redesigned and hence 

obtain its maximum optimisation. The element dimensions are created without the need of 

having to introduce coordinate systems or rigid meshes. 

 

2 Program description 

2.1 Basic functions 
All the options of CYPE 3D can be selected from the menus on the right and from the drop-

down menus at the top of the main screen. The two selection zones can be seen in the 

figure below. 

 

Figure 1 

An option can be selected from either of the two menus. 
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2.1.1 How to introduce a node 

To introduce a node, click on Node > New. 

There are four ways of introducing a node. 

 Using coordinates. Type the coordinates using the number pad on the keyboard. Type 

in the X coordinate and press ; the Y coordinate and press ; and the Z coordinate 

and press . 

 By clicking directly on screen using the mouse. When working in a 3 dimensional 

view, nodes should only be introduced over a blue reference line or over a bar. When 

working in a 2 dimensional view, the node can be introduced at any point. If there are 

no existing reference lines, one will be created at that moment. 

 Snap using DXF or DWG. DXF or DWG file templates can only have 2 dimensions to be 

visualised in a 2D window. Once a DXF or DWG view is available, a node can be 

introduced by clicking with the mouse with the aid of the object snap settings. Nodes 

introduced in this way do not require their separation dimensions to be indicated as 

the DXF or DWG will already contain that information. 

 Import of a text, DXF or DWG file. In these cases, the program processes the 

information of these files and generates nodes and bars according to the information 

contained in the file. These formats will be commented on later. 

 

 

2.1.2 How to introduce a bar 

Click on Bar > New and follow the same procedure as was done to introduce the nodes.  

Bear in mind that a bar has an initial and a final node and the same must be done to 

introduce a bar as is to introduce two nodes. A bar can also be introduced between two 

existing nodes. 

N.B.: When a node has been introduced, regardless of whether this has been in a 3D or 

a 2D window, its relative dimensions will eventually have to be established. It is 

important to do this as soon as possible, otherwise the user may risk forgetting, which 

will result in a warning message appearing during the analysis indicating a node is 

present without dimensions. At that moment it may be difficult to detect the node in 

question if the structure being analysed contains hundreds of nodes. Be careful to 

distinguish between a 2D view and a rotated 3D view which may appear to be a 2D 

view. 
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2.1.3 Element selection 

For the majority of options, the different components of the structure must be selected to 

work with them. Generally speaking, there are two types of elements: 

 Finite dimension elements. These consist of nodes and bars. They may be selected in 

two different ways: 

 Click on the element. Once selected, if clicked on again, the selection of the node or bar 

is cancelled. 

 Click at a point where no element is present, drag without letting go and click at 

another point. This way a rectangle is created with part of the structure contained 

within it. If the rectangle is created from left to right, its perimeter will be shown as a 

continuous line and only those elements it completely contains will be selected. If the 

rectangle is created from right to left, its perimeter will be displayed as a discontinuous 

line and all the elements that are completely or partially contained within the rectangle 

will be selected. Selected elements will be displayed in magenta. 

 Non finite dimension elements. These are reference lines, i.e. lines generated upon 

introducing a node or bar. These are shown drawn in light blue. Three lines are always 

generated per node, in accordance with the three main axes. If an option is chosen 

which implies the selection of one of these reference lines, upon clicking on the line, it 

will automatically be selected. By clicking on it again, it will become unselected. If the 

intersection of three reference lines is clicked on, all three will be selected. 

2.1.4 Order criteria of bar nodes 

When a bar is introduced, the program needs to know which is its initial and final node. 

These criteria do not hold any relation to the introduction order of the bar ends. 

The order criteria is as follows: end 1 has the smallest Z coordinate. If the Z coordinate is 

the same at both ends, end 1 is that possessing the smallest Y coordinate. If the Y 

coordinates are also the same, end 1 is that corresponding to the smallest X coordinate. 

2.1.5 Reference systems 

There are four reference systems: 

 General axes or global axes 

 Local bar axes or bar x-axis 

 Local plane axes of the bar or horizontal x axis 

 Local axes of the section 
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At this point when ‘bar’ is mentioned, this is done in reference to an immaterial section 

that, when described, will coincide with the longitudinal axis of the section. The section is a 

material element, which can be steel, concrete or any other material described in the 

program. 

The diversity of the reference systems is due to the program allowing the user to work and 

introduce data in a 3D system. 

The first three systems are used to introduce loads. The last for buckling related issues and 

result consultation of a specific section. 

 General axes. These are drawn in the bottom left hand corner of the screen and a 

represented by a trihedron indicating the direction and positive sense of the axes. 

 Local bar axes. In this case, the X axis coincides with the direction of the bar. 

The Z axis is perpendicular to the X axis and is contained in a vertical plane, which 

contains the local X axis and is parallel to the general Z axis. 

In the case of a vertical bar, i.e. parallel to the general Z axis, and as there are infinite 

vertical planes containing the X axis, the reference vertical plane to obtain the local Z 

axis is parallel to the general ZY plane. The Y axis is perpendicular to the local X and Z 

axes of the bar. 

Regarding their direction, the positive X direction is from node 1 to node 2. The positive 

Z direction is always upwards. That is, if the local Z axis is projected on the general Z 

axis, it has the same positive direction as the general Z axis. Finally, the positive 

direction of the local Y axis is the direction corresponding to fastening a screw rotating 

from the local Z axis to the local X axis via the shortest route. 

 Local axes of the plane of the bar. If the bar is introduced using a 2D view, the plane 

of the bar is precisely that 2D view. 

If the bar is introduced in a 3D view, the plane of the bar is the vertical bar, i.e. the 

plane containing the bar and that, additionally, is parallel to the general Z axis. 

Bearing in mind what has been said previously, the local X axis of the plane of the bar 

is the projection of the local X axis of the bar on the intersection of the bar with the 

general XY plane. 

The local Z axis of the plane of the bar is the projection of the local Z axis of the bar on 

the intersection of the plane of the bar with the general ZY plane.  

The local Y plane of the bar coincides with the local Y axis of the bar. 
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 Local axes of the section. These axes exist as of when the bar is described, i.e. when 

the section of the bar has been identified (Specific steel section, rectangular concrete 

section, etc.). The local axes of the section coincide with the local axes of the bar. 

However, if the section is rotated, the axes of the section rotate with it, whereas the 

local axes of the bar do not. 

As a guide, the general axes are drawn in the bottom left hand corner of the screen. The 

local axes of the section are also shown when the Describe bar option is selected and 

when introducing the Buckling data. 

The local axes of the bar and the local axes of the plane of the bar can be deduced easily 

based on the local axes of the section. 

Additionally, for the majority of structures, knowing which are the global axes and the local 

axes of the section, which are drawn on screen, will suffice.  

To understand the other two reference systems, read their description carefully and think 

of a three dimensional view. 

 

2.1.6 Creation of windows with new views of the structure 

To create new windows displaying 2D and 3D views, use the option Window > Open New. 

A new window can be selected amongst the following types: 

 2D view in a plane orthogonal to the X, Y or Z axis. To create the new view, select two 

coplanar lines using the mouse. 

 2D view of a plane. To a new view to appear, click on three non-aligned nodes and 

contained within the plane to create. 

 3D view of the whole structure. Upon clicking on accept, a new 3D view of the whole 

structure will be created. 

 

Figure 2 
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2.2 Different bar sections 

2.2.1 Steel bars 

Steel bars, editable or from section tables, are available in different arrangements 

depending on their shape and type of steel. 

When selecting a section, its position and combination with other elements can also be 

selected. 

Its properties can be indicated in the options that appear on screen. For example, if a 

rolled steel section is selected, the user can select whether it consists of a simple section or 

if it has lateral plates, if it has haunches, if it is double in a box with batten plates, etc. 

 

Figure 3 

Each case contains different options. 

For sections welded together, the user can choose whether it is a continuous or 

discontinuous weld. 

 

Figure 4 

If the layout is that of two sections welded together with batten plates, the separation 

between the sections can be selected. The user can also choose the type of steel to use for 
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the batten plates as well as indicating their spacing or, alternatively, allow the program to 

design the spacing. 

The batten plate sections can be established in two different ways: 

 Generic plate. In this case, the program calculates the geometry of the plate 

 Plate series. Here, the program uses the rectangular pate series to select the 

adequate plate. If the library used in the job at the time does not possess a rectangular 

section series for the batten plates, the option will not be available until a suitable 

series is created or imported. 

 

Figure 5 

When the joint is generic, as well as the separation between the sections, the user can 

choose the type of joint: 

 Independent. The element is treated as two independent sections where the other is 

not considered when verifying buckling or slenderness. 

 Joined at maximum distance. The program calculates the distance between the 

generic joints so the section can be considered a built-up section.  

 Joined at given distance. The user indicates the distance between the joints. 
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Figure 6 

When selecting a section with haunches, the user can choose between initial or final, top or 

bottom. 

 

Figure 7 

Castellated beams are also available. There is a range of web opening shapes available: 

hexagonal, octagonal or circular. The user specifies the dimension ratios and number of 

filled openings at the ends of the beam. 
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Figure 8 

If a section with a concrete slab is chosen, the user can introduce the real width and 

effective width of the slab, its thickness, the distance to the section and activate the partial 

composite action. The user can also indicate the type of concrete and its creep coefficient. 

 

Figure 9 

In the case of welded sections, depending on the selected section, the options available 

are: 

 Simple section. 

 Double with generic joint. When selected, this contains similar options as to those 

found in rolled steel sections when using the option Double in box generic joint. 
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 Four with generic joint. This is similar to the previous option, only more options are 

available when considering the separation between sections. 

 

Within the sections options, an ample variety of editable sections are available. For 

example by choosing the Deck section, the user may choose between a circular hollow 

section or a 6, 8, 10 or 12 sided tube. Additionally, different diameters can be applied to the 

initial and final ends of the bar. This way, circular, hexagonal, octagonal, decagonal and 

dodecagonal truncated cone sections can be introduced. 

 

Figure 10 

 

Figure 11 

As well as rolled and welded steel sections, the program offers cold-formed steel and ties 

with their respective sections and options. 

Using the  icon, further explanations can be obtained on the various options. 
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2.2.2 Extruded aluminium 

The program has the option of using extruded aluminium bars, designed according to 

Eurocode 9. These are introduced in the same way as steel bars. 

 

Figure 12 

2.2.3 Special aluminium sections 

The aluminium extrusion process has the advantage that as well as being able to obtain 

standard transverse aluminium alloy sections, specific designs can also be obtained. The 

program uses an Extruded aluminium section editor, which allows for the design and 

check of aluminium alloy bars with specific transverse sections.  

Upon clicking the Special aluminium section button, a dialogue box opens with options to 

create, copy, edit and manage a library of special extruded aluminium sections. Using the 

create button (or edit button, once special sections have been defined), the extruded 

aluminium section editor is displayed on screen. 

The specific design of the section increases the range of available transverse sections, 

allowing for an optimum combination which simplifies the constructions process of the 

structure, with mechanical properties which maximise the resistance effectiveness with 

minimum weight. The program also offers the possibility of stiffened sections without 

having to use composite sections, which avoids having to weld or bolt the components. 

Using the extruded aluminium sections editor, any section can be created: open, with cells, 

made up of thin walled flat elements… and used in the structural analysis to proceed with 

the resistance calculation, including the corresponding check reports. 
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Figure 13 

 

Figure 14 

 

Figure 15 
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Figure 16 

 

Figure 17 

The editor offers information on the mechanical and torsional properties of the gross 

section, required for the structural analysis, which is updated after any modifications have 

been carried out. Properties displayed include the section’s area, moment and product of 

inertia, torsion module, warping constant and shear centre coordinates. 

Using the calculated resistance of the sections created with the editor, the section is 

checked for the forces derived from the structural analysis. The analysis incorporates an 

automatic calculation of the section’s susceptibility against the local buckling of the thin 

walled elements making up the transverse section, assuming each one buckles 

independently. The local buckling coefficient which affects the slenderness parameter of 

each element can be edited and so be able to consider other buckling modes. The section 

is classified based on the previous analysis, and with it, the effective properties, elastic or 

plastic, are obtained which will then be used for the resistance checks. 
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2.2.4 Timber bars 

Timber bars can be circular, square, rectangular and rectangular with variable depth. 

 

Figure 18 

CYPE 3D calculates timber structures and carries out the structural verification and design 

of the elements in accordance with Eurocode 5 (including fire resistance check). 

Timber sections are introduced in the same way steel structures are introduced; by using 

the option Bar > Describe section. A section library containing the most common sections 

is provided. The library can be managed in a similar way as the steel library whereby it can 

be edited and personalised. 

 

Figure 19 
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The timber used for the structure has to be assigned a service class depending on its 

environment: 

 Service class 1: Is characterised by material humidity content at a temperature of 20ºC 

and relative air humidity exceeding 65% only a few weeks per year. 

 Service class 2: Is characterised by a material humidity content at a temperature of 

20ºC and relative air humidity exceeding 85% only a few weeks per year. 

 Service class 3: When climatic conditions leading to humidity contents greater than 

those of service class 2 are found. 

 

The service class is to be defined once the section has been accepted in the Bar > Describe 

section option. The service class can also be defined by clicking on Job > Timber sections. 

Within this dialogue, the Check fire resistance box can be activated, which checks the 

structure against fire in accordance with Eurocode 5 part 1-2. The analysis is carried out 

using the reduced section method which verifies the load capacity of each element using 

an effective section, which in turn is obtained by deducting the effective carbonisation 

thickness from the initial section. 

 

Figure 20 

The effective carbonisation depth is determined as a function of the carbonisation speed of 

the timber for the Required resistance, and bearing in mind if a surface protection has 

been applied (in the form of wood derived planks or plasterboard planks) and its respective 

failure period, if any. 

The section verification is carried out in a similar manner as is for steel and aluminium 

sections. Once the forces acting on the bar have been calculated (Analysis > Analyse), any 

sections not verifying one or more conditions of the selected code are displayed in red. 
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Upon clicking on one of these bars, a dialogue box appears displaying all the members of 

the series and indicating which of them are suitable and which are not. If the Check fire 

resistance option has been activated, the verification in case of fire will only be 

undertaken if the section verifies all the required conditions for normal situations. 

It is equally possible to know the use factor of each section by selecting the option 

Analysis> U.L.S. checks, having analysed the job. If the fire resistance check has been 

activated and the section fails, a message will appear when checking the U.L.S. of the 

section: ‘Fire resistance check failed’. If, on the contrary, the section passes all the fire 

checks, its use percentage will be displayed. 

When calculating with the fire resistance check, any length variations the elements may 

suffer due thermal conditions are not considered by the program. 

Timber sections have to be assigned a resistance class depending on their mechanical 

properties in a way to guarantee the value of the properties of the timber are equal to or 

greater than those corresponding to the assigned Resistance class. The types of timber and 

corresponding resistance classes considered by the program are those present in the UNE 

EN 338 and UNE EN 1194 codes for solid and laminated wood respectively: 

 Wood sawn from conifers or poplars. 

Resistance class: C14, C16, C18, C20, C22, C24, C27, C30, C35, C40, C45, C50. 

 Wood sawn from frondescent species. 

Resistance class: D30, D35, D40, D50, D60, D70. 

 Homogenous glue laminated wood. 

Resistance class: GL24h, GL28h, GL32h, GL36h. 

 Combined glue laminated wood. 

Resistance class: GL24c, GL28c, GL32c, GL36c. 

 

Figure 21 

To assign the type of timber and resistance class, select the bar(s) in question and click on 

Bar > Describe material. Alternatively, the bar(s) may be assigned the type of timber 

selected in Job > Timber sections. The properties of the material required to calculate the 
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forces, such as tensile, compression, shear and bending resistances are assigned 

automatically by the program once the type of material has been assigned. 

2.2.5 Concrete bars 

Circular and rectangular (with constant or variable depth) may be defined. The program 

calculates the forces which these bars are submitted to and displays the results by simple 

loadcases, combinations or envelopes. The resistance of concrete bars is not checked, i.e., 

their sections are not checked or designed. 

 

Figure 22 

2.2.6 Generic bars 

Generic bars of any other material may be defined. The program calculates the forces 

which these bars are submitted to and displays the results by simple loadcases. The 

resistance of the generic bars is not checked, i.e. their sections are not checked or 

designed. The user defines the following properties of the bars once they have been 

positioned: 

Section geometry. The user introduces the distances between the centre of gravity and 

the surrounding outline of the section in the two directions of each of the local axes of the 

section: 

 Left width 

 Right width 

 Bottom depth 

 Top depth 

Mechanical characteristics 

 Area 

 Shear area Avy 

 Shear area Avz 

 Bending inertia Iyy 

 Bending inertia Izz 

 Torsional inertia It 
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Material 

 Modulus of elasticity 

 Poisson’s ratio 

 Coefficient of thermal expansion 

 Unit weight 

 

Figure 23 

 

2.3 Basic introduction of a structure 

The introduction of a 3D structure is defined in 3 phases: 

 Geometrical and structural introduction 

 Bar and node description and their properties 

 Definition of load states and loads to which the structure is submitted. 

 

2.3.1 Geometrical and structural introduction 

There are two ways of introducing the geometry: by importing a DXF/DWG file with the 

drawing of the structure in 3D and its corrects coordinates or by manual introduction of 

the structure with the aid of the implemented drawing tools to facilitate data entry. 

Data entry by importing a DXF or DWG file 

Within the Job menu, the option Import DXF and DWG files can be found. Once the 

selected file has been read, within the Object selection window, the layers which are to be 

imported can be selected. Upon selecting each layer, it will be highlighted in blue in the 

graphics area of the window. 
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Figure 24 

This way, the geometry of the structure is rapidly introduced, having only to describe the 

nodes and bars, their attributes and loads. These topics shall be seen later on. 

Manual data introduction 

Within the 3D views only nodes or bars with known coordinates will be possible, to do so, 

the reference lines of other previously introduced nodes or bars have to be captured. To 

facilitate this task, the program has the following options available: 

 Snap and grid cursor. Upon activating this option, the movement of the cursor is 

forced within the interval of the points defined within the increment option and 

ignoring any in between. 

 Repeat the last selection. Using this option, any bars, nodes or loads which were 

previously selected are re-selected. 

 Object references. In the same way as these are selected for a DXF/DWG file, this 

option allows to activate the object snaps on the program options (nodes and bars). A 

tracking option is available which can be configured for example, if the Extension line 

us activated, the extension of a bar is snapped to when one approaches it with the 

cursor, it is drawn as a discontinuous line. 

If, after the introduction of a bar, the option Draw dimensions is selected (Dimensions tab 

in the configuration  window, displayed in the toolbar), the program will attach using the 

selected display colour, the length and angle corresponding to the preceding point if it 

consists of a non-defined point. If the Edit the dimension button is activated on the 
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toolbar , upon clicking on the second point, a window will appear asking to confirm or 

edit the distance. 

 

Figure 25 

There are a series of buttons in the top part of the dialogue box with which it is possible to 

define other functions. For example, the X and Y distances can be introduced, or 

alternatively the length and angle. 

         

Figures 26-27 

Depending on the plane on which is being worked on, the available options will vary. If an 

existing bar is selected, the program will ask for the distance to the closest node or snap 

point of the bar. 

If, during the introduction of a bar, a known point is selected, upon pressing with the 

cursor, the background colour is eliminated which indicates that a dimension will not be 

required, as the coordinates of the point have already been defined. This will not occur if 

the Edit the dimension option is deactivated, which implies having to use the generic 

dimensioning options found in Planes > Dimensions. 

 

Figure 28 

An option which should be taken into account when introducing a structure is that of Bar > 

Generate nodes at intersection points. Once this option has been activated, nodes are 

generated at bar intersections. If this option is deactivated, the bars will cross without 

generating a connection between them. 
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Planes menu options 

 Dimensions 

Upon selecting this option, the following window will open displaying the available 

procedures: 

 

Figure 29 

o Add dimensions. Used to dimension the structure. Once the nodes and bars have 

been introduced, upon clicking this option, it is possible to modify their dimensions 

by clicking on the two nodes defining the distance which is to be dimensioned and 

typing the distance. 

o Delete dimensions. Deletes incorrect dimensions; select two reference lines of the 

dimension to delete. 

o Show dimensions. Displays previously hidden dimensions. 

o Hide dimensions. Using this option, it is possible to deactivate the dimensions 

which are not to be visible in the drawings. Select the two reference lines to hide, 

which will be drawn in grey. 

 References and Show/hide planes 

These two options are found in the Plane menu and are both used to view reference 

lines. 

The difference is that the References option allows to deactivate or activate specific 

groups of reference lines of the structure, whereas the Show/hide planes option allows to 

select which reference lines will be visible or hidden for a group of nodes.  

 Show/hide new planes 

Using this option, it is specified that reference lines will be generated upon introducing 

new nodes within the structure. These can be displayed using the Show/hide planes 

options. 

 Group 

This is used when there are equal parts of the structure contained in planes parallel to 

orthogonal axes. Using this option, it is possible to group planes with these properties 

in such a way that when a modification is carried out, it is equally carried out on the 

rest of the grouped planes. 
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To group the planes, select Planes > Group and from the emerging window, select the 

type of plane to group (XY, XZ,YZ) and select the nodes through which the plane 

belonging to that group passes. It will be assigned a number. 

 

 Ungroup 

To ungroup the planes, select Planes > Ungroup and from the emerging window, 

which plane is to be ungrouped (XY,YZ,YZ) and select the nodes through which the 

planes to ungroup pass through. 

 

2.3.2 Bar description and their properties 

Once the geometry of the structure has been introduced, the bars and nodes can be 

described. The following options are located in the Bar and Node menus. 

Describe section 

This option is contained within the Bar menu. Using this option, the user can specify 

the type of section previously selected bars are to have. To do so, open a selection 

window using the mouse or, alternatively, select the bars one by one: as a bar is 

approached by the cursor, it will be highlighted in blue. At that moment, by clicking on 

the left mouse button, the bar(s) will be selected and displayed in orange. By then right 

clicking with the mouse button, the Describe section window will open where the 

section to assign to the bars can be defined. 

Within the Describe section window, a wide range of section sizes and materials are 

available: the user can select amongst rolled, welded, cold formed, aluminium or 

timber sections. These are selected by clicking on their corresponding button which 

will allow the user to choose from a section series or define the section. Having 

accepted the options, upon returning to the Describe section window, the selected 

section will be displayed in the top right hand corner. 

 

Figure 30 
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Describe disposition 

This option is located within the Bar menu; once activated, the Describe disposition window 

will appear in which the angle of the section can be chosen as well as its position relative to 

the axis of the bar. 

 

Figure 31 

The angle of the section can be defined in reference to the local axes of the bar or using 

the option to calculate the rotation angle relative to the plane of the active window. 

 

Figure 32 

 

Using the Describe disposition option, it is possible to define the displacement of the axis 

of the bar with respect to the definition line of the bar. By being able to define the 

eccentricities, the more the analysis model resembles the real structure, and hence the 

program can take into account the introduced displacements and use them in the stiffness 

matrices of the different elements. To change the position of the axis, click on one of the 

nine points of the diagram of the section (corners, mid-point of a face or the axis of the 

section) and upon doing so, the new position of the axes can be seen. A displacement in Y 

and/or Z can be applied. Once the window has been accepted, the displaced section will be 

drawn relative to the definition line; a dash-dot line will be drawn at the position of the axis 

of the section so those sections whose axis positions have been change can be identified 

more easily.   
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Figure 33 

To interpret the results provided by the program correctly, it is very important to take into 

account that, even though the section has been displaced, the surrounding conditions 

(support conditions, reactions, imposed displacements, etc.) are applied at the nodes 

situated at the introduction axis. Additionally, forces continue to be represented on the 

introduction axis, which in turn correspond to the centre of gravity of the sections. 

 

Invert the direction of the X axis of the bar 

Upon clicking on a bar with this option activated, the direction of the local X axis of the bar 

is inverted. This way, symmetrical bar layouts can be obtained in the structure if non 

symmetrical sections are used such as Z sections or angles. 

Changing of the axis of the section inverts the initial and end positions of the bar. For cases 

where fixity coefficients have been applied or loads have been applied, the program will 

automatically modify the introduced data so these do not undergo any alterations due to 

the modification of the axis. 

 

Figure 34 

Describe material 

Once the sections have been described, the same process must be repeated to describe 

the material of each bar of the structure. 

Create elements 

This option is used when several aligned bars behave as a single bar.  
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To create the element, select the first node from the first bar then the second node from 

the last bar forming the element. 

Group 

This option allows to match sections, in such a way that the greatest section is assigned to 

the selected sections. This situation can arise if the sections are designed differently due to 

the forces to which they are submitted, however for more homogenous results, the 

sections are matched.  

Click, using the left mouse button, on the bars to be grouped and, once selected, click with 

the right mouse button to unselect. To add a bar to a group of bars, select a bar from the 

group then the bar to be added.  

Ungroup 

Cancels the Group option and separates the grouped bars. 

Buckling 

This is used to assign  coefficients to bars and hence modifying their buckling lengths. This 

can be done manually by selecting the coefficient depending on each buckling plane or 

using the option Approximate calculation of buckling lengths. 

 

Figure 35 

 

Lateral buckling 

This option activates the check for lateral buckling of the top or bottom flange or both by 

introducing the buckling  coefficient. 
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Figure 36 

Fixity at ends 

Fixity coefficients can be modified in their XY and XZ planes. 

 

Figure 37 

 

Create and Edit deflection groups 

Within the program, the deflection groups are created automatically. If these are to be 

modified or create a new group, click on the first node of the group and on the end node of 

the group.  

Using this option, the user can specify if the deflection is secant (default option) or tangent 

to node 1 or tangent to node 2. 

 

Figure 38 
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Limiting deflections 

These options allow for deflection limits to be assigned to elements, the value to introduce 

will be left to the user’s opinion. 

 

Figure 39 

Information 

This option displays as a report, a list of the data of the selected bars as well as the use 

percentage regarding resistance and deflection. 

 

Figure 40 
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Node description 

Now the bars have been described, the following step consists in describing the nodes. 

When a node is introduced in the program, it is introduced, by default, as fixed. If the 

degrees of freedom of the nodes or their fixities are to be modified, this can be done using 

the options: Internal fixity and External fixity located in Node menu. 

 

Internal fixity 

This option defines whether bars reaching a node are to be fixed or pinned. 

 

Figure 41 

External fixity 

This option defines the fixity of bars reaching external fixities, such as connections 

introduced in the Beam Definition of CYPECAD. 

 

Figure 42 

2.3.3 Ties 

Ties may be defined between nodes. The ties between the nodes are used to indicate that 

two or more nodes have the same displacements for all the loadcases. The option is 

located in the Node menu where the displacement can selected in one, two or three 

directions in accordance with the X, Y and Z global axes. The number corresponding to 

each group of nodes whose displacements have been tied is displayed on screen. 

Bear in mind that for two or more nodes to have the same displacement, an element or 

construction arrangement must be present in the structure that will effectively materialise 

the equal displacement hypothesis. 

Ties cannot be assigned to nodes that form part of braced frames when the tied 

displacement has its projection on the plane of the braced frame. 
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2.3.4 Loads and analysis 

Loadcases are defined using the following option: Job > Load > Additional loadcases. 

Once the loads have been defined, the user can access the option located in the Load 

menu.  

To facilitate data entry, load introduction on nodes and bars is treated as two separate 

options. 

Viewed loadcase 

A scroll menu allows the user to select the loadcase of the structure to be viewed. 

Alternatively, all the loadcases can be visible simultaneously. 

 

Figure 43 

Scales 

Different scales may be assigned to loads, either by loadcase or type (point, uniform…). 

 

Figure 44 

Introduce loads on bars 

Select the bars on which the same load is to be applied followed by a click with the right 

mouse button in for the loads window to appear. Here, the loadcase, type of load (point, 

line, uniform…) can be selected and its value and angle introduced. The load can also be 

defined relative to the local axis or global axis of the bar. 
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Figure 45 

Introduce loads on nodes 

This option is similar to the previous option, whereby the loadcase is to be selected and the 

value and angle of the point load is to be indicated. 

 

Figure 46 

Once the loads have been introduced, these can be modified or deleted using the Edit and 

Delete options. 

Analysis 

This option calculates the structure. It contains several options: 

 Do not dimension sections. Performs a quick analysis of the forces of the isolated 

structure without changing the sections that have been introduced. 

 Quick section design. Designs the sections of the structure using the current forces 

and increases the size of those sections that fail. 

 Optimum section design. Designs the sections with the current forces and increases 

the size of those section that fail. By increasing the sections, greater forces are 

generated and therefore the program performs a second analysis to see whether the 

sections are valid. If these fail, they are modified and the program runs through 

another analysis. The program continues this process until suitable sections are found. 

This option is slower than the previous two options but provides a more exact result. 



 

 

 

CYPE 3D – User manual / 33 

The design options can be carried out using all the sections of the series or using sections 

of the series greater than the current sections.  

An additional option includes designing the joints of the structure (acquired as a separate 

module). All the user must do is indicate whether these are to be resolved as bolted or 

welded connections. 

 

Figure 47 

Check bars 

Upon activating this option, bars that do not verify all the conditions are displayed in red. If 

one of these is clicked on using the mouse, a window appears displaying a list of all the 

sections within its series, whether they are suitable or not, their weight per meter length, 

their used resistance and a description of the encountered error, if any. 

The selected section is highlighted in blue; to change the section, double click on another 

which will in turn be shown highlighted in blue. 

 

Figure 48 

 

Displacements 

Using this option, the displacements of the selected nodes and bars can be viewed, 

allowing for the possibility of selecting the displacements corresponding to a specific 

loadcase, combination or combination envelope. 
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Upon clicking on a bar, the displacements of its initial and final nodes will appear. To 

deactivate the option, right click with the mouse button. 

 

Figure 49 

Reactions 

This option allows to consult the reactions at supports with external fixity. The type of 

loadcase, combination or envelope can be selected. This option is similar to the previous 

option. Click on the supports for which the reactions are to be seen. 

 

Figure 50 
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Batten plate distribution 

Using this option, the batten plates designed for each bar are displayed. 

Force diagrams 

Force, deflection and deformed shape diagrams of the bars are graphically displayed using 

this option. 

 

Figure 51 

Values at a point 

This option allows to consult the forces and deflection of bars. 

 

Figure 52 
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Envelope and Envelopes at a point 

Using the Envelope option, the force, deflection and used values of the bars can be 

viewed. There is an additional option of viewing the Envelopes at a point (as in the case of 

Force diagrams). 

 

Figure 53 

Alternatively, a more personalised list of elements can be obtained by selecting the desired 

bars and nodes upon clicking on Job > Reports on a selection of elements.  

 

2.3.5 Joints 

The program also designs welded or bolted connections, depending on how the user 

wishes for them to be resolved. 

 

Figure 54 
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Within the Options menu, the user can choose whether to use prestressed or non-

prestressed bolts i.e. ordinary bolts, and specify their steel class and range of diameters 

that are available. Further options include whether or no to always provide haunches at 

element connections. 

 

Figure 55 

 

2.4 Foundations 

2.4.1 Baseplates 

Materials: The type of steel to be used for the bolts and baseplates is to be selected as 

well as the type of concrete. 

Options: The thickness of the levelling mortar must be selected (this thickness will only 

affect the anchorage length of the bolts, where the thickness of concrete within the mortar 

is not considered as forming part of the anchorage length), as well as indicating several 

geometrical rations to aid in the baseplate design.  

Generate: This option allows for baseplates to be generate  at the bottom of the steel 

columns.  

Delete: Using this option, previously introduced baseplates may be deleted. 

Edit: Upon selecting this option and clicking on a baseplate, a dialogue box will open where 

the baseplate can be designed automatically or check its design with modified data from 

the user. 
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Figure 56 

 Baseplate: If specific baseplate dimensions are to be used or those proposed by the 

program are to be modified, these may be specified here. 

 Layout: The position of the centre of the baseplate with respect to that of the steel 

section can be modified in this option. The data introduced here will be considered 

with in the automatic design of the plate. 

o Centred: This is the default option whereby the axes of the baseplate and steel 

section coincide. 

o By coordinates: The distance to the centre of the baseplate with respect to the 

axis of the section is introduced. 

o By initial overhang: When this value is left as zero, the program adjusts the initial 

face of the section to the initial edge of the baseplate. If this value is altered, the 

section will move the inwards by the amount stated in the Overhang field. 

o By final overhang:  When this value is left as zero, the program adjusts the final 

face of the section to the final edge of the baseplate. If this value is altered, the 

section will move the inwards by the amount stated in the Overhang field.  

 Stiffeners: Using this option, stiffeners may be introduced or those proposed by the 

program may be modified. 

 Bolts: This option contains the options relative to the bolts to be used in the design. 

These may be used upon designing the baseplates for the first time or, alternatively, 

modifying the results proposed by the program. 

o Concrete anchorage: The type of anchorage of the bolts within the concrete is to 

be selected. Depending on the steel that has been chosen as the steel to be used 
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for the bolts, the available options will vary. The options include straight extension, 

90º hook or 180ºhook. 

o Diameter and length: Diameter and straight length of the bolts (the length of the 

hook is not included). 

o Corner: If this option is activated, four bolts will automatically be placed, one in 

each corner of the plate. Otherwise, only those bolts stated in the next two options 

will be introduced. 

o Number of bolts in X: Total number of bolts in the two X faces of the plates (not 

including those that may have been introduced as corner bolts). 

o Number of bolts in Y: Total number of bolts in the two Y faces of the plates (not 

including those that may have been introduced as corner bolts). 

o Distance from edge to bolts: Distance from the axis of the bolts to the edge of 

the plate. Note that the Code used to design the baseplate will provide a minimum 

distance. Therefore if this is modified, it must be verified it complies with the Code 

in question.   

 Code checks: The program carries out a Code check of the baseplate. This tool is 

useful if the user has introduced the baseplate data or if the baseplate proposed by 

the program has been modified and requires verifying. When the process has 

concluded, a report of the assessed checks is available. 

 Design: The program automatically designs the baseplate so it verifies all the limits 

established by the Code and user. Any specifications introduced in the Baseplate, 

Stiffeners and Bolts options are not taken into account; only those in the Layout 

option. If the user wishes to modify the baseplate, it may be done having concluded 

the design and then perform a Code check.  

 3Dview: Provides an isometric view of the baseplate and section. 

Match: This options allows for one baseplate to be selected and assign it to other 

baseplates so to achieve more uniform results.  

Check: Once the design has been carried out, upon clicking on this option, any baseplates 

not verifying all the results will be displayed in red. If one of these baseplates is clicked on, 

a dialogue box will appear warning that not all the checks have been verified and prompts 

whether or not the user wishes to view the report of assessed checks, so to view why the 

baseplate has failed. 

Design: Simultaneously analyses and designs the foundations: pad footings, pile caps (the 

user must have previously indicated the soil and footing data in Foundation tab > Job > 
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General data / Options), and baseplates. If any errors arise, the program will provide a 

warning when running the design. 

 

2.4.2 Foundation options 

General data and Options from the Job menu: The user can specify the data to be used 

in the design of the foundations such as: the type of concrete and steel for footings or pile 

caps. The geometric cover (to the reinforcement surface) can be modified, the maximum 

aggregate size (to verify the spacing of the reinforcement bars), the thickness of the mud 

slab and the allowable bearing pressures. The design options and reinforcement tables 

may also be modified.  

Reinforcement tables: The program designs the foundations using the table within its 

library (Predefined table). The user can import a table (Library table) or select to create a 

table by modifying the existing Predefined table and saving it as a Special table. The job is 

designed using the selected table amongst the three available options. 

 

Figure 57 

 Predefined table: This table is the default table installed in the hard drive. It cannot be 

deleted or directly modified. It can be consulted by clicking on the Special table option 

then on Edit table. 

o Button displaying name of the predefined table: If there are several predefined 

tables, the one to be used by the program in the design may be selected here.  

o Export the predefined table to the library: If the predefined table is to be modified, 

use this option which creates a copy of the table within the library which may then 

be modified. A name will be required for the new table. 

 Library table: These are tables created by the user, which are available for the current 

job as well as any future or past jobs.  

o Button displaying the name of the library table: If there are several library tables, 

the one to be used by the program may be selected here.  
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o Edit the library tables: This option accesses the Library edition dialogue box. Within 

this window, new tables may be created or deleted, or copy or edit existing tables. 

When editing a table, new reinforcement may be added etc. The button: Import 

older tables, only appears when there are reinforcement tables belonging to older 

versions of the program. This option imports the tables to the library. Having 

imported them, the program will prompt whether the old format is to be deleted.  

 Special table: This table is exclusive to the current job. This button duplicates the 

previously selected reinforcement table (Predefined or Library table). 

o Edit table: Allows to edit the Special table. 

o Export the special table to the library. The special table is exclusive to the current 

job, however, it may be exported to the library so it may be used in other jobs. If it 

is exported, the program will prompt the user for a name for the exported table. 

If a table is created for an element and the user wishes to use it in other jobs it 

should be exported using the Export to library option. It can be used immediately 

in other jobs using the inverse option, Import from library. Another option consists 

in Edit library which allows to create, modify, etc. the elements in the general 

library. 

 

Foundation elements: The program has a series of foundation elements available for its 

design. These include pad footings and pile caps. 

 Type of footings (reinforced or mass concrete): 

o Square 

o Centred rectangular footing 

o Eccentric rectangular footing 

o Tapered square footing 

o Tapered centred rectangular footing 

o Tapered eccentric rectangular footing 

 

Figure 58 
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Figure 59 

 Type of pile caps: 

o Pile cap for 1 pile 

o Pile cap for 2 piles 

o Pile cap for 3 piles 

o Pile cap for 4 piles 

o Strip pile cap (number of piles to be chosen, default value of 3) 

o Rectangular pile cap (number of piles to be chosen, default value of 9) 

o Rectangular pile cap for 5 piles 

o Pentagonal pile cap for 5 piles 

o Hexagonal pile cap for 6 piles 

o Hexagonal pile cap for 7 piles 

 

Figure 60 

 New: Introduces a new footing (reinforced  or mass concrete ) or pile cap  to 

be selected from the types in the list above. Strap and tie beams to be introduced are 

also selected here. 

 Delete: Deletes an existing foundation element. 

 Edit: Analyses and designs the pad footing, pile cap or strap or tie beam, or verifies the 

element designed by the user. 

Once the foundations have been generated, these may be edited. Upon clicking on the 

element to be edited, the following dialogue box will appear containing the options 

described below: 
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Figure 61 

 

 

Figure 62 

 

 Materials: Modifies the properties of the materials and the allowable bearing pressure 

(in the case of mass and reinforced footings) of the soil assigned in the General Data 

dialogue box. 

 Piles (only for use with pile caps): The type of pile, its penetration, the separation 

between piles of the pile cap and number of piles (in the case of a strip pile cap) can be 

modified. 

 Geometry: Here, the dimensions of the footing may be modified. If the user wishes to 

carry out a check on a footing or pile cap with specific dimensions, these may be 

introduced and then the program will calculate the necessary reinforcement by clicking 

on Design > Redesign. If the footing or pile cap is to be designed with minimum 

dimensions (i.e. the user wishes for the dimensions to be at least the values that have 

been introduced and if necessary, the program will increase them) click on Design > 
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Minimum dimensions. In the case of pile caps, the overhangs are always indicated with 

respect to the axis of the pile. 

o Geometry of a square footing: the dimensions of the length and depth of the 

footing are required. 

o Geometry of the centred rectangular footing: the dimensions of the x width, y 

width and depth of the footing are required. 

o Geometry of the eccentric rectangular footing, the following data is required: 

- Initial x width (overhang of the footing to the left) 

- Final x width (overhang of the footing to the right)  

- Initial y width (overhang of the footing to the left) 

- Final y width (overhang of the footing to the right) 

- Depth of the footing 

o Geometry of the tapered square footing: the total width, pedestal width, pedestal 

depth and edge depth are required. 

o Geometry of the tapered centred rectangular footing: the dimensions of the x 

width, y width of the footing are required as well as the x and y widths of the 

pedestal, the pedestal depth and edge depth. 

o Geometry of the tapered eccentric rectangular footing, the following data is 

required: 

- Initial x width (overhang of the footing to the left) 

- Final x width (overhang of the footing to the right)  

- Initial y width (overhang of the footing to the left) 

- Final y width (overhang of the footing to the right) 

- Pedestal x and y widths  

- x and y coordinates of the pedestal (centre of the intersection) 

- Edge depth 

 

 Reinforcement: Using this option, the reinforcement proposed by the program can be 

modified. 
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o Bottom mesh: the diameter of the bars, their separation and type of anchorage is 

to be defined. 

o Top mesh: the diameter of the bars, their separation and type of anchorage is to 

be defined. 

o Perimeter reinforcement: its diameter and separation. 

 

For pile caps, the reinforcement depends on the type of pile that has been selected 

and if beams are present for the type in question.  

 

 Options: For rectangular footings with a centred or eccentric start, the options 

available are those in relation to the direction of growth of the footing. 

 Code checks: This option allows the user to verify the footing or pile cap and the 

reinforcement introduced by the user or if these have been modified based on the 

automatic results generated by the program. Having concluded the process, an report 

is available detailing the checks that have been carried out. The checks that are carried 

out do not take into account any specifications imposed by the user, only the criteria 

and codes of the program. 

 Design: Automatically designs the footing or pile cap and its reinforcement verifying all 

the limits established in the selected code and the data of the user. There are several 

options:  

o Complete: calculates the dimensions and the reinforcement of the footing or pile 

cap without bearing in mind any geometrical limits stated by the user. 

o Minimum dimensions: Verifies the footing or pile cap does not fail with the 

minimum dimensions introduced in the Geometry option by the user. If it does 

fail, it increases the geometry to what is required; the dimensions are never 

decreased. 

o Redesign: Only designs the reinforcement without modifying the dimensions 

introduced in the Geometry option. 

 

Having concluded any of these three processes, a report displaying the checks that 

have been performed can be obtained. 

 Match: Allows to assign a footing to others. These will be displayed in red if they fail a 

check. 
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 Information: By clicking on this option and then on a footing or pile cap, the allowable 

bearing pressure, dimensions and reinforcement are displayed. 

 Move: Allows the user to move the position of the footing or pile cap. 

 Rotate: Rotates the pad footing or pile cap about its centre axis. The possibilities are 

as follows: 

o Manual introduction of the angle 

o Two point introduction. Select two points on the screen defining the direction 

vector and click on the foundation element 

o Angle of the column. Click on the foundation element followed by the column 

bearing on the foundation whose angle is to be adopted. In the case of several 

columns bearing on the same foundation, the angle taken by the program is that 

of the first column introduced. 

 Join: Allows for several footings to be joined and combined to make a single footing. 

Not applicable to pile caps. The selection of the footings is carried out using the left 

mouse button and concluded with a right click. 

 

2.5 Strap and tie beams 

Rigid bending is not considered in the case of tie beams or strip footings however it is in 

the case of strap beams which balance the load and act as tie beams (they absorb the 

moments produced at the base of the columns, due to the eccentricity of the force normal 

to the columns with respect to the axes of the footings and transferred to the axes of the 

footing). 

The program does not consider the beams to be supported by the ground. 

The program allows the user to assign the ‘balancing’ to one or both ends. For example, in 

the case of a beam running from a centred pad footing (with respect to the column) to an 

eccentric pad footing, the user can balance the end reaching the eccentric footing and 

leave the other as a tie beam. 

Strap and tie beam options: These are located in the Foundations tab > Foundation 

elements menu. 

 New: When introducing a new beam, the user can choose between: 

o Tie beam . 
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o Strap beam . These balance the moments transmitted by the columns, shear 

walls and walls to the foundations relative to their axes. Any type of footing can be 

balanced. 

o Beam with automatic balancing at ends . Using this option, the user can 

introduce a beam between two previously introduced footings and the program 

will automatically balance the ends which require balancing because the footing 

they reach is eccentric with respect to the supported element(s) (e.g. edge footing, 

corner footing, etc.).  

 

Figure 63 

 Edit: After the general analysis, the result obtained for the beam can be modified. The 

footing can be designed independently and later on, design the beam. 

 

Figure 64 
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To do so click on the Edit button and select a beam. A window containing the following 

options will open: 

o Selection. This allows for the type of beam to be modified. The new beam (of the 

same type) can be selected from the scroll list. 

 

Figure 65 

 

o Stirrups. If the options are activated, the stirrups of the strap beam will be 

extended into the foundation up to the column starter bars. 

o Anchors. Modifies the anchorage lengths. 

o Code checks. Verifies the current beam. Once the process has concluded, a list of 

all the verifications that have been carried out is available. 

o Design. Automatically designs the beam and applies all the conditions stated in 

the code selected by the user. Once the process has concluded, a list of all the 

verifications that have been carried out is available. 

o Detailing. A transverse and longitudinal section of the beam is displayed, with its 

reinforcement and dimensions. 

o 3D view. Provides a 3D view of the beam. 
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Figure 66 

 

 Delete: Deletes a previously introduced beam. 

 Match: Having previously edited a strap or tie beam and then clicking on this option, 

those beams that are the same will be highlighted. By right clicking on the mouse 

button and clicking on a different type of beam, any that are equal to it will then be 

highlighted. 

 Adjust: Adjusts the edge of a beam to the furthest foundation vertex.  

 Extend: Allows the user to extend an end of the beam. 

 Move: This option allows to move the end of a beam or the entire beam. 

 Balance ends: Allows for the balancing action to be activated or deactivated upon 

clicking at the end in question. If the strap beam balances the load at a specific end, a 

curved arrow will appear indicating that the balancing is active. If the arrow does not 

appear, the balancing at that end is not active. 

2.6 Complementary options 

2.6.1 Automatic generation of the structure using DXF or 

DWG files 

As described in section 2.3.1, this option allows for the geometry of a structure to be 

generated using a DXF or DWG file in which the bars have been drawn. It also allows for the 

possibility to deactivate the bars that are not to be generated.  

It is very important that one drawing unit be equal to one metre.  
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Having chosen this option (Structure tab > Job > Import DXF and DWG files), the 

DXF/DWG file to be imported must be selected. The import process begins immediately 

and concludes by displaying the Object selection window where the entities to import can 

be selected. 

 

Figure 67 

The DXF/DWG appears in perspective; therefore it is possible to import DXF/DWG files in 

3D. To import the selected layers, mark the respective boxes. By clicking in the top left 

hand corner of the box, four further options are available for a more rapid selection. 

 

Figure 68 

 

2.6.2 Exporting reports in TXT, HTML, PDF and RTF formats 

and preliminary views 

CYPE 3D allows for all the generated reports to be exported in TXT, HTML, PDF and RTF 

formats. The selection of elements to export is carried out upon executing the Print 

option: File > Print > Job report. A dialogue box will appear where the selection can be 

made. 
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Figure 69 

It is equally possible to obtain a preliminary view of the list. 

 

2.7 Undo and Redo options during data 

introduction 

CYPE 3D contains the Undo and Redo options which allow to cancel the last operations that 

have been carried out or redo those which have been cancelled using the previous option. 

2.7.1 Displacement of the image on screen 

To displace the drawing on screen, select the ‘pan’ icon  from the toolbar at the top of 

the screen (the current option in use is left on hold), click and hold the left mouse button so 

to drag the image on screen to the desired position. To deactivate the option, re-click on 

the pan icon. Alternatively, instead of using the pan icon, hold down the scroll button of the 

mouse and move the mouse to displace the image.  

When this option is selected the vertical and horizontal displacement bars appear on 

screen.  

2.7.2 Change of background colour 

The background colour may be modified within the Configuration menu in the top right 

hand corner of the screen (displayed as a globe). 

 

Figure 70 
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2.7.3 Selection of recently opened jobs 

Within the menu File > Recent files, the user has access to the latest jobs that were 

accessed. 

2.7.4 Automatic generation of loadcase combinations 

Additional loadcases may be defined by clicking the option in the dialogue box which opens 

upon clicking on Job > Loads. The option displays all the loadcases of the job and allows for 

them to be edited as well as allowing for other loadcases to be added (dead, live, wind, 

earthquake and snow loads) and establish their compatibility conditions. 

 

Figure 71 

To create a new loadcase, click on the Edit icon  to the right of the name of the 

loadcase. A dialogue box opens which will display any additional loadcases that have been 

defined. A new loadcase can be added by selecting the New additional loadcase button in 

the top left hand corner. Another dialogue box will appear where the reference and 

description can be defined. An extra option appears: With different load dispositions. By 

activating this option, the compatibility of the loadcases can be defined (compatible, 

incompatible or simultaneous). This is useful when defining alternating loads, mobile loads 

etc. 

 

Figure 72 
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Figure 73 

The load dispositions are a group of special loads which belong to the same loadcase. 

These can be: 

 Compatible: The load groups can be applied on their own or combined with other 

load groups belonging to the same loadcase. 

 Incompatible: The load groups do not combine with other load groups of the same 

loadcase (for example in the case of wind loading where the wind is blowing in a given 

direction and will not be combined with wind blowing in another direction). 

 Simultaneous: The combinations of the defined additional dispositions are generated 

taking into account that they all act simultaneously. This type can be used when 

wishing to define a group of loadcases divided into load groups and so make them 

easier to edit, visualise, etc. 

Once the dialogue box has been accepted, and having defined at least two additional 

loadcases, the program will display a table at the bottom of the dialogue box where the 

combination between loadcases of the same nature can be combined amongst 

themselves. 

2.7.5 Limit states 

This option is selected by clicking on the option in the dialogue box which opens upon 

clicking on Job > Loads. Having done so, the Limit states dialogue box appears allowing the 

user to define the execution control, use category and snow level. By clicking on the pencil 

and question mark icon on the right, the combination generated by the program can be 

consulted and where the partial safety coefficients g and combination coefficients y are 

indicated.  

2.7.5.1 Combination configuration for each limit state 

This option can be found in the bottom part of the Limit states dialogue box and allows to 

specify the limit states for concrete, foundations, cold formed steel, rolled steel, aluminium 

and timber. For any of these, the option Project situations introduced by the user can be 

selected. This option allows the user to specify the particular project combinations to be 

used situations to in the calculations corresponding to the structural elements of the job. 
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Figure 74 

The following options are available to define the project situations introduced by the user: 

  Create new situations 

 Delete previously introduced situations 

 Copy the selected situation 

 Edit the selected situation 

 Library manager to use the situations in other jobs 

 Create based on data of situations stated in the selected code 

 

 Create new situations 

By clicking on the  button, the Create – [Situations] window will open: 

 

Figure 75 

A reference must be introduced to indicate the situation that is going to be defined. 

Having done so, click on the Add new element to the list button  and the 

Combination coefficients window will open. 
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Figure 76 

Here, the user can define the combinations in two different ways: by safety factors or by 

safety and combination factors.  

For the first case, the data to introduce is as follows: 

 

Figure 77 

 

For the second case: 

 

Figure 78 

 Edit situations 

If this option is selected , dialogue boxes similar to those displayed when creating 

the situations appear: 
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Figure 79 

All the previously defined situation parameters can be edited in this dialogue box. 

 Create based on the code situations 

By selecting this option (  button), code project situations of the selected material can 

be imported and modified to the user’s needs. This reduces the possibility of errors 

occurring when introducing the coefficients. 

 

Warning 

By offering the user the option to create the project situations, the user is given a certain 

degree of freedom for the analysis of the job. Therefore special attention must be paid to 

not create project situations which may imply that the final results have an applied safety 

factor less than that required by the selected code. 

 

2.7.6 3D View 

The 3D view of the structure can be displayed as an isometric projection or in perspective. 

 

Figure 80 
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Figure 81 

Whilst viewing the 3D structure, the user can move inside it. The point of view can be 

modified by using the rotation bars at the top and left of the screen. If the structure is 

zoomed into (using the zoom option from the toolbar) displacement bars will appear at the 

bottom and to the right of the screen. 

 

Figure 82 

 

The mode in which it is viewed can be changed by clicking on the ‘eye’ button  of the 

toolbar at the top left hand side of the 3Dview window. 
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2.7.7 Export to other programs 

CYPE 3D allows for the designed steel structure to be exported so it may be viewed and 

modified in other programs. The Export options are located in File > Export. Additionally, 

the option exists to export in CSI/2 format. CIS/2 (CIMsteel Integration Standards) is a 

standard interchange format to facilitate data flow between applications which intervene in 

the analysis, design and fabrication process of steel structures. CYPE 3D can export the 

introduced and designed structure in CIS/2 format, advised by the NIST (National Institute 

of Standards and Technology) so it may be use in others programs later. 

 

Figure 83 

External loads acting on the structure can be introduced in the program, so to obtain its 

optimum design in accordance with the selected code. Additionally, the construction details 

of bolted and welded connections of rolled and welded I sections that are generated can 

also be exported to other programs and obtain a 3D model of the whole in that program. 

There are two options when exporting: 

 Only geometry and properties of nodes and bars. Exports the geometry and steel 

sections recognised by the program it is being exported to. The structure does not 

have to be analysed or designed before it is exported. It does not include the export of 

joints and so these do not have to be designed before exporting either. 



 

 

 

CYPE 3D – User manual / 59 

 

Figure 84 

 Complete detailing of the structure, including joints. Exports the geometry of the 

job, the steel sections recognised by the program it is being exported to and the joint 

detailing corresponding to the steel elements. The job and joints must be analysed 

before exporting. 

 

Figure 85 

Please consult our web-site for the minimum program requirements to use these options. 

2.8 On screen help 

CYPE programs have on screen help icons to provide the user with the necessary 

information on the program menus, dialogue boxes and options. 

There are four different ways to access the help options: 

2.8.1 Pressing F1 

To obtain help on a menu option, press F1. All the icons with help explanations available 

will be highlighted in blue. If you wish to obtain help on an option within a menu, having 

pressed F1, unfold the menu and click on the desired option. 
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2.8.2 Question mark icon 

A question mark icon  can be seen at the top right hand corner of the title bar. Specific 

help on a program option can be obtained the following way: click on the question mark 

icon then unfold the menu containing the option for which the help is sought and click on 

the option. A window will appear containing the required information. This option provides 

the same information as when the F1 key is pressed.  

This help can be deactivated in three ways: by clicking on the right mouse button, by 

clicking on the question mark icon or by pressing the Esc key. 

You can equally obtain information on the toolbar icons. Upon selecting the question mark 

icon , the icons will be highlighted in blue (as with the F1 option). By then clicking on the 

icon, the help information will be displayed. 

Option windows that open within the program also contain the question mark icon in their 

title bar. By clicking on it, the option or icon help can be accessed.  

2.8.3 Book icon 

Within the title bar of several windows, an open book icon  can be found which upon 

clicking on it will display general information on the contents of the window. 

2.8.4 Quick guide 

The option information displayed using the F1 key can also be consulted and printed out 

by selecting Help > Quick guide. These explanations are those corresponding to the 

options found within the screen tabs. 

The explanations in the dialogue boxes are different to those of the guide. 

2.8.5 About… 

Displays information of the program, its name and version. A button in the bottom right 

hand corner displays the license number of the dongle which when clicked upon displays a 

list of all the acquired modules and codes. At the bottom of this dialogue box, the 

configuration of network hardlock button can be found, which allows for the dongle to be 

configured in the user’s machine. 
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